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Preface 
 

This manual has been produced for employees who work with the office of the 
executive vice chancellor for business affairs in preparing and submitting agenda items 
for regular meetings of the Board of Trustees. They are: 
 
 Primary Contact Local Business Officer Editor Backup Editor 
BHC Richard McCrary   George Herring Dawn Bishop Edna Love 
CVC Jennifer Wimbish Huan Luong Bonnie Shipp  
EFC Jean Conway Jim Jones Melanie Reynolds Brenda Stevenson 
ECC/BJP Paul McCarthy David Browning Shirley Henthorn Ida Keller 
MVC Felix Zamora Sharon Davis Pat Standifer Tim Soyars 
NLC Herlinda Glasscock Christa Slejko William Videtto April Burns 
RLC Kay Eggleston Ron Clark Janet James Terry Lefler 
LCET Pam Quinn Dottie Clark Karen McClendon Linda Turner 
DO Andrew Jones Edward DesPlas Treschell Seymore Karen Settles-Lee 
DO Denys Blell Edward DesPlas Benita Briggs Dawn Segroves 
DO Kathryn Tucker Edward DesPlas Theresa Rose Toni Barajas 
DO Betheny Reid Edward DesPlas Mark Ballard Kathye Hammontree 
DO Robert Young Edward DesPlas Marilyn Herridge Maria Miller 
DSC Kim Green Edward DesPlas Diana Wilder Latricia Speede 
DSC Clyde Porter Edward DesPlas Eddie Tealer  Eric Lewis 
DSC Philip Todd Edward DesPlas Cindy Wilburn Diane Banta 
DSC Steve Park Edward DesPlas Julie Winn  
DSC John Lopez Edward DesPlas Elsa Hernandez  
 

The authors welcome suggestions for improvements. Please send via e-mail to 
Barbara Corvey. 
 
Dates for Your Calendars 
  

State statute requires that notice of the Board meeting and the agenda be posted at 
least 72 hours before the meeting. As a rule, the chancellor’s staff posts the official notice 
and agenda in the Dallas County Records Building and at the DCCCD Offices at 1601 
South Lamar, Dallas, by noon on Friday before a 4:00 p.m. meeting the following 
Tuesday.  Nothing can be added to the agenda after the posting deadline. 
 
 Notice of the Board meeting and agenda are also posted on the internet at 
http://www.dcccd.edu/About+DCCCD/Board+of+Trustees/Board+of+Trustees+Meeting
+Agendas/, at DCCCD’s administrative offices, colleges and other sites.   
 
 As a general rule, regular meetings of the Board of Trustees are held at 4:00 p.m. 
the first Tuesday of each month. 
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FY 2009-10 the cut-off dates for submitting agenda items through the EVCBA are 
listed in the chart below.  Note that agenda items for a regular Board meeting will be 
accepted ANY TIME IN ADVANCE of the deadline. 

 
If possible, submit agenda items two months before the month of the proposed 

effective date.  For example, for a contract that is proposed to be effective Sept. 1 through 
Aug. 31—submit for the Trustees’ consideration at the regular July meeting. To do so 
gives them ample opportunity to request more information which may be assembled for 
the chancellor to discuss with them.  Action may then be taken at the regular August 
meeting, prior to the Sept. 1 effective date. 

 
In addition to regular monthly meetings on first Tuesdays, the Board conducts 

occasional work sessions; the Board Audit Committee meets quarterly; and the Board 
Budget and Planning Committee meets once or more each Fall, Spring and Summer 
semesters.  Notices of changes to cut-off dates for EVCBA agenda items are sent by e-
mail to everyone named in the table on page 3 of this manual. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
At the discretion of the executive vice chancellor for business affairs, agenda 

items that are incomplete, contain errors, and/or are received after the deadline may 
be returned and/or deferred for submission to the following month.  Note: If there is 
reference in an agreement or contract to an appendix, letter of agreement or other 
documents, these must be supplied by the deadline for the submission to be 
considered “complete.”  

 
 

 Agenda items to be processed through the
EVCBA’s office for the Board meeting on  
Tuesday … ∧  
 

 
 
 …will be accepted any time and up until
Noon on …  

January 5, 2010 ∧  December 8, 2009 
February 2, 2010 ∧  January 19, 2010  

March 2, 2010 ∧  February 16, 2010 
April 6, 2010 ∧  March 22, 2010  

May 11, 2010  ∧    April 27, 2010  
June 1, 2010 ∧  May 18, 2010  

July 6, 2010 ∧    June 22, 2010  
August 3, 2010 ∧ July 20, 2010  

September 7, 2010 ∧ August 23, 2010  
October 5, 2010 ∧ September 21, 2010  

November 9, 2010 ∧ October 26, 2010  
December 7, 2010 ∧ November 18, 2010  
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There have been occasions when an agenda item has been submitted before the 
cut-off date, followed by one or more unsolicited, revised versions after the cut-off date. 
When this occurs, the agenda item is treated as having been received after the cut-off date 
and may be returned and/or deferred for submission to the following month. 

 
The Board of Trustees is not obliged to grant retroactive approval of contracts.  It 

is always advisable to negotiate beginning dates that occur following, not on or before, 
the anticipated date of Board action.  Readers are reminded of Board Policy CF 
(LOCAL), RESPONSIBILITY FOR DEBTS:  

 
The Board shall assume responsibility for debts incurred in the name of the 

District so long as those debts are for purchases made in accordance with adopted Board 
Policy and current administrative procedures.  The Board shall not be responsible for 
debts incurred by persons or organizations not directly under Board control; persons 
making unauthorized purchases shall assume full responsibility for all such debts. 

 
Workflow for Preparing and Submitting Contracts (other than personnel) 

  
Step Who What 

1 Originator Identifies need for interlocal agreement, contract $25,000 or 
greater for similar services in a 12-month period, educational 
services agreement $250,000 or greater in a 12-month period, or 
other action that requires approval by the Board of Trustees.  
NOTE: As a general rule, it is inadvisable to negotiate contracts 
that span more than one fiscal year.  DCCCD’s fiscal year is 
September 1 – August 31.  If compelled to cross fiscal years, 
confer as soon as possible with your local business officer about 
the Board policy on this subject.   
 
For more information about Board policies pertaining to 
interlocal agreements, educational services agreements, and 
other contracts, see 
http://www.tasb.org/policy/pol/private/057501/, particularly but 
not only Chapter C.  The search function is helpful for locating 
additional information.   
 
If uncertain about how to proceed, contact the local business 
officer or Robert Young, legal counsel. 

2 Intervening 
supervisor(s) 

Approve in concept? YES indicates anticipated benefits justify 
anticipated costs. 

3 Originator If answer to #2 is NO: re-evaluate need and develop alternative 
plan. 
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Step Who What 
4 Local business 

officer 
YES indicates a) funds are already or expected to be available, 
and b) other anticipated financial terms and conditions, as far as 
can be known at this stage, are within the realm of DCCCD’s 
policy, procedures and good business practice. 

5 Originator If answer to #4 is NO: re-evaluate need and develop alternative 
plan. 

6 DSC purchasing 
director 

Need to advertise and solicit formal requests?  Depending on 
services and entities that may be the ultimate provider, the DSC 
director of purchasing may consult with legal counsel before 
answering.  NOTE: This consultation with the DSC director of 
purchasing may be initiated by the originator or the local 
business officer, depending on the workflow that is unique to the 
location where the item is originating.   

7 DSC purchasing 
director 

If answer to #6 is YES: handled through purchasing department 
from this point forward. NOTE: Formal procurement processes 
sometimes require more time. It is important to consult with 
purchasing as early as possible. 

8 Originator, 
intervening 
supervisor(s) 
and local 
business officer 

If answer to #6 is NO and action involves selecting a contractor: 
review procedures for selecting contractors.  Develop rating 
sheet and list of parties to receive invitations.   
 
See Board Policy Manual, 
http://www.tasb.org/policy/pol/private/057501/, type CF in the 
Go to Policy Code section/enter to view document titled 
Purchasing and Acquisitions, and  
See Business Procedures Manual,  
http://www.dcccd.edu/shared-
nfs/intranet/dcccd/business_affairs/bpm/470.pdf to view section 
4.7.0.  If action involves rental or other action, follow applicable 
policies and procedures set forth in publications named above.  
Real estate matters are not handled by the purchasing department 
and are not subject to competitive bidding. 

9 Originator Extend invitations; evaluate respondents. 
10 Originator and 

intervening 
supervisor(s) 

Select contractor. 

http://www.tasb.org/policy/pol/private/057501/
http://www.dcccd.edu/shared-nfs/intranet/dcccd/business_affairs/bpm/470.pdf
http://www.dcccd.edu/shared-nfs/intranet/dcccd/business_affairs/bpm/470.pdf
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Step Who What 
11 Originator Secure contractor’s signature on three (3) originals of instrument 

supplied by contractor or by DCCCD’s legal counsel, or, on one 
of DCCCD’s multi-part forms, whichever instrument is most 
appropriate to the agreement.  The two most frequently used 
DCCCD’s multi-part forms are Professional Services Contracts 
and Institutional Agreements.  [Note: Signature line for the 
chancellor is required and is styled as Wright L. Lassiter, Jr., 
Chancellor.]  Attach signature tabs to the right side of each page, 
aligned with each signature line for the chancellor (or, this may 
be done by the editor).  If the agreement requires signature by a 
witness (or has an “attest” line), then attach another tab to the 
right of each of these. 

12 Originator 
(Note: NOT the 
editor) 

Draft Board agenda item using language in the templates 
provided by the office of the executive vice chancellor of 
business affairs as a guide, where applicable.  If the boilerplate 
in the template is not a perfect fit, consult with local business 
officer or review recent Board agendas to find samples of how to 
adapt the language. 
 
See  
http://www.dcccd.edu/sharednfs/intranet/dcccd/business_affairs/
home.html for EVCBA's Board Agenda up-to-date templates.  
[Note: Write in third person, not first or second.]  Forward 
agenda item and contract(s) to supervisor. 

13 Originator, 
intervening 
supervisor or 
local business 
officer1 

Where indicated by the nature of the agenda item, list each 
entity that responded to the request for proposals.  
 
See sample transmittal message on page 21 for an example of 
how to convey information.  

14 Intervening 
supervisor(s) 

Accurate and complete?  If answer is NO: return to #12. 

                                                 
1 Each primary contact (these are named on page 3) is responsible for assigning responsibility for the 
collection of this information.  It may be the responsibility of the originator, an intervening supervisor, the 
local business officer, or some other position.  

http://www.dcccd.edu/shared-nfs/intranet/dcccd/business_affairs/home.html
http://www.dcccd.edu/shared-nfs/intranet/dcccd/business_affairs/home.html
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Step Who What 
15 Local business 

officer 
NOTE: 
Originator is 
primary source 
of estimated 
revenues and 
expenditures, 
which are 
validated by the 
business officer. 

Accurate and complete?  YES indicates conformance with all 
applicable provisions of Board Policy Manual and Business 
Procedures Manual.  Validates or corrects originator’s statement 
of estimated revenues and expenditures, if such a statement is 
indicated by the nature of the contract.   
 
Provides explanation for any amounts not specifically found 
in the contract.  Forwards to primary contact.   
 
 
If answer is NO: return to #13. 

16 Primary contact 
(see p. 3) 

Approve?  YES indicates endorsement of proposed activity, 
cost, timeframe, recommended contractor, and other relevant 
conditions.  If yes, forwards to legal counsel. 

17 Primary contact 
(see p. 3) 

If answer to #15 is NO: return to local business officer for 
resolution of issue(s). 

18 Legal counsel Approves form of the agreement?  If YES, enters initials at 
chancellor’s signature line on each of three (3) original 
contracts, or, on DCCCD’s multi-part form.  [Notes: a) A 
handwritten change to a contract must be initialed by the 
contractor and DCCCD’s legal counsel before this step is 
complete.  b) Amendments and change orders are also subject to 
review by legal counsel before being submitted to EVCBA’s 
office.] 

19 Primary contact 
(see p. 3) and 
local business 
officer 

If answer to #17 is NO: resolve issue(s), involve other parties as 
needed. 

20 Primary contact 
(see p. 3) 

Content of agenda item accurate and complete? 

21 Primary contact 
(see p. 3) 

If answer to #19 is NO: edit. 

22 Primary 
contact’s 
editor2 (see p. 
3) 

Format correct?  YES indicates conformance to guidelines for 
submitting agenda items to EVCBA.  Ensure Barbara Corvey in 
the EVCBA’s office has the agenda item in electronic format, 
AND all contract documents on or before the cut-off date for the 
Board meeting at which you want action to be taken. 

23 Primary 
contact’s editor 
(see p. 3) 

If answer to #21 is NO: edit, then complete step #21. 

                                                 
2 Or back-up if the editor is absent.  Editors and back-up editors are encouraged to coordinate their 
schedules so that one is always available.  
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Step Who What 
24 EVCBA’s 

office:  
Barbara Corvey 

Process each agenda item and prepare for transmission to the 
chancellor’s staff, to include: 
• Editing content and format of agenda items,  
• Returning agenda items to primary contacts when indicated, 
• Recommending deferral of agenda items when indicated,   
• Matching contracts to agenda items,  
• Inserting agenda items into appropriate sections of the 

agenda (separate files for building and grounds, financial, 
informative and consideration of bids reports),  

• Reviewing agenda items with EVCBA,  
• Preparing transmittal to Kathryn Tucker, executive director,  

board relations, and 
• Publishing exception reports to primary contacts when 

indicated. 
25 EVCBA  Approve? 
26 EVCBA staff If answer to #24 is YES, deliver to Kathryn Tucker on or before 

deadline she has established.   
27 EVCBA If answer to #24 is NO: advise primary contact.  “Next steps” 

vary at this point according to circumstances. 
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Saving the Templates 
You need to save the templates to your computer to use them. The templates can 

be accessed online at www.dcccd.edu/dsc/dsc-home.htm. Click the Business Affairs - 
IntraNet link.  The templates are located under the section “EVCBA's Board Agenda 
Templates” Follow the steps below. 

 
Downloading and Saving the Board Templates 

Follow the steps below to download and save the templates. 

1. Right-click the Board Template link desired and choose “save target as” from the 
right-click menu that appears. 

 
2. A dialogue box as seen below will open.  Important: Make a note of the filename 

that appears, (write it down as shown OR press Ctrl + C on your keyboard to 
copy the filename for later use).  Note: The filename will be different for each file. 

 

 

Be sure to save the 
template file to your 
network drive or location 

http://www.dcccd.edu/dsc/dsc-home.htm
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Note:  If a File Download box appears then click the Save button and the dialogue 
box above will open automatically.    

3. Click the Save as type arrow at the bottom of the box and select Document 
Template if available, otherwise leave as Microsoft Office Word 97 - 2003 
Document.   

 

4. From the Save in: field at the top of the box, select the location or a network drive on 
your computer to save the document for future reference such as Desktop, My 
Documents,  your P:\ or U:\ drive on the network.  [Note: Your P:\ or U:\drive is 
preferable because files there are automatically backed up whereas if your desktop 
computer fails, your files may be lost.      

 You want to organize all the templates into one folder. 

Step 3: Save as type 

Step 5: new folder 

Step 4: Save in field 

Step 6: File name 
field and Save 
button 

5. Click the new folder button at the top of the box, type in Board Templates and click 
OK. 

6. Enter the original filename in the File name: field at the bottom of the box and click 
the Save button. 

7. After you have completed the Template download and save steps, continue with the 
Save Additional Templates on page 12.       
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Save Additional Templates 
 
Any subsequent templates will also be saved in the Board Templates folder you 

just created so the process changes a little at one point: 

1. Download and save any additional template files. (See Downloading and Saving the 
Board Templates steps 1-2). 

2. Displaying the Save As dialog box. 

3. Click the Save as type: arrow at the bottom of the box and select Document Template 
if available. . 

4. Choose the location (e.g. P/…) in the Save in: field at the top of the window.  

5. Double-click the Board Templates folder in the list. 

Step 4: Save in 

Step 3: Save as type 

Step 5: Board 
Templates folder  

Step 6: File name 
field and Save 
button 

6. Enter the original filename in the File name: field at the bottom of the box  
 

7. Click the Save button. 
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Opening and Using the Board Templates only  
1. Open Word. 

2. Open the File menu and select New… to start a new file based on the templates 
you have already saved. 

3. The New dialog box will appear. Click the Board Templates tab. It is displayed 
because you created the Board Templates folder earlier. The templates you have 
saved display in the box. 

4. Double-click the template you need to use. It will open as a Word document:   
BoardAgreement_Template or BoardInterlocalContract_Template.   
 
 

                                              

Board 
Templates folder 

Templates 

 
Table Gridlines 

The templates were created using tables as placeholders. The gridlines will not print but 
show up on screen as grey borders. If you cannot see the gridlines after opening the 
template, use the following process to show them. 

1. Table  Show Gridlines 

If you wish to turn the gridlines off to see how the page will print: 

2. Table  Hide Gridlines 
 

In Word 2007, click on any line of information   

3. Layout tab now available under Table Tools tab  in Table group  click 
View Gridlines  click again to Hide Gridlines  

Software Training 13 Questions of Style 
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5. The template has bracketed fields for inserting information – [Click HERE and 
enter…] – so click there and enter the information provided by your authors 
(originator, intervening supervisors, local business officer and/or local cabinet 
member).  Note: in an amount not to exceed must include the total anticipated 
expenditure (fees + reimbursable expenses, etc., as enumerated in the contract).  
Following is page 1 of the template called BoardAgreement.dot: 

 

 
 

 
 

6. The phrasing in the templates is for contracts for services.  If the agenda item 
you are submitting is something different, substitute appropriate language.  
Use the template for all agenda items to assure uniformity of margins and 
other formatting conventions. 

Software Training 14 Questions of Style 
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Page 1 of BoardAgreement.dot asks for additional information. 
 

Background 
 
[click HERE and enter relevant background, if any]: Whether or not there is 
relevant background may be known by the originator (author), business officer, 
primary contact, or EVCBA staff. 
 
[If a request for retroactive approval, click HERE and explain why]: An 
occasional bona fide emergency, such as storm damage to a roof that requires 
immediate repair, may necessitate engaging a contractor prior to Board approval. 
However, the starting date of almost all other contracts can be negotiated to begin 
after the Trustees have given their authorization. In situations where this has not 
happened, authors (especially business officers and cabinet members) should describe 
honestly the circumstances that led to a request for retroactive approval and what 
steps will be taken to avoid the same thing from happening again.  Primary contacts, 
business officers and originators are advised that costs incurred prior to Board 
approval of a contract, bid, quote or other award that requires Board action may be 
treated as the employee’s personal expense.   
 
Copies of 1) the invitation to prospective parties for statements of qualifications, 
price and availability, and 2) the rating instrument for evaluating respondents’ 
competency, experience and capability relative to the assignment, are available 
from the cabinet resource named below.  Parties who responded to the invitation 
are the following: 
 
[click HERE and list parties in alpha order]  
 
This recommendation has undergone the following administrative review: 
• An assessment from the director of purchasing that this work was not suited 

to solicitation of formal bids or quotes (if applicable); 
• Approval of the form of the agreement from DCCCD’s legal counsel; 
• Assurance from the local business officer, 

[click HERE and enter name & lowercase title per  p. 24] , that relevant 
provisions of the Board Policy Manual have been observed; 

• Approval of the substance of the agreement by 
[click HERE and enter cabinet member's name & lowercase title per  p. 24] . 

 
The preceding paragraphs verify that employees have followed written policies and 
procedures and must be included (unless it is untrue). Never include an untrue 
statement simply because it is part of boilerplate language in a template. Instead, 
authors should substitute a paragraph that describes the selection process that led to 
recommendation of this contractor. 
 

Software Training 15 Questions of Style 
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Estimated revenues are $[click HERE and enter amount or delete if NA] .  
Estimated expenditures are $[click HERE and enter amount or delete if NA] . 
 
Do not include an estimate of state reimbursement. The preceding paragraph may be 
drafted by the originator or intervening supervisors. It must be validated by the local 
business officer and must provide information about any items that are not found in 
the agreement.  If the EVCBA’s staff checks and cannot verify funds are budgeted, 
the agenda item will be returned or deferred until budgets are verified. 
 
The last row of the table contains the Submitted by [click HERE and enter 
cabinet member info per Appendix A] field. If you do not need this field because of 
duplication of the last bullet point information, you should delete that row and the 
row above it so there is no unnecessary spacing at the end of the template. 
 

Delete/Add Rows 
1. Make sure you can see the table gridlines: 

Table  Show Gridlines 
2. Place your mouse pointer out to the left of the table until it changes to a white 

arrow pointing to the right 
3. Click and drag to select the rows to delete 
4. Right click Mouse  Delete/Insert Rows or  

Table  Delete Rows or Table  Delete  Rows 
 
Note for Microsoft 2007 to delete a row/column 
1. Make sure you can see the table gridlines by clicking on any line of information, 

Layout tab now available under Table Tools tab  View Gridlines in Table group 
2. Select the row that you want to delete by clicking its left edge  

 
2. Right click Mouse  Delete Rows/Insert or  
3. Layout tab  Rows & Columns group  Delete image/arrow  Delete 

Rows/Columns…Insert Above/Below/Left/Right or 
Rows & Columns group line, double click arrow for Insert Cells menu 

 
Add Spacing 

Occasionally, after inputting your information into the template’s fields, a section 
may break across pages. If there is only one line or a few lines of a large section 
breaking to the next page, consider re-wording to condense the text and pull the 
line(s) up to the previous page. If most of the section falls on the next page, click 
above the section, in a blank row, and press the Enter key on the keyboard to push the 
entire section to the next page. 
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FINANCIAL REPORT NO. [Chan's office ONLY: click HERE and enter #]  
 
 Approval of Agreement with 

[click HERE and enter name of contractor EXACTLY as on contract]  
 

It is recommended that authorization be given to approve an agreement 
with [click HERE and enter name of contractor EXACTLY as on contract]  in an 
amount not to exceed 
$[click HERE and enter amount, e.g., 35,000 or 34,999.99]  for the period 
[click HERE and enter effective date as, e.g., September 1, 2002]  through 
[click HERE and enter effective date, e.g., August 31, 2003] , to provide 
[click HERE and enter brief description of services, e.g., a lecture series]  for 
[click HERE and enter name of DCCCD location, e.g., Brookhaven College] . 

 
Background 

 
[click HERE and enter other relevant background, if any]  
 
[If a request for retroactive approval, click HERE and explain why]  
 
Copies of 1) the invitation to prospective parties for statements of qualifications, 
price and availability, and 2) the rating instrument for evaluating respondents’ 
competency, experience and capability relative to the assignment, are available 
from the cabinet resource named below. Parties who responded to the invitation are 
the following: 
 
[click HERE and list parties in alpha order]  
 
This recommendation has undergone the following administrative review: 
• An assessment from the director of purchasing that this work was not suited to 

solicitation of formal bids or quotes; 
• Approval of the form of the agreement from DCCCD’s legal counsel; 
• Assurance from the chief business officer, 

[click HERE and enter name & lowercase title per  p.24] , that relevant 
provisions of the Board Policy Manual have been observed; 

• Approval of the substance of the agreement by 
[click HERE and enter cabinet member's name & lowercase title per  p.24] . 

 
Estimated revenues are $[click HERE and enter amount or delete if NA] . 
Estimated expenditures are $[click HERE and enter amount or delete if NA] . 
 
Submitted by "[click HERE and enter cabinet member info per Appendix A]"  

Software Training 17 Questions of Style 



Dallas County Community College District  Preparing Agenda Items 

Questions of Style 
 Unless otherwise noted, observe guidelines in The Associated Press Stylebook 
and Briefing on Media Law.  [Note: The office of the executive vice chancellor for 
business affairs has provided a copy of this manual to each cabinet member’s editor plus 
Denise Zackery, Clyde Porter and Philip Todd at the District Service Center.  If you wish 
to obtain additional copies, contact David Bartley at 972-860-7788.] 
   
Following are DCCCD-specific styles for the Board agenda.  Some of these are in 
addition to what is contained in the AP Stylebook; some are exceptions to the AP 
Stylebook.  The following list also contains spellings to be added to your Word spelling 
and grammar check. 
 
Abbreviations   For DCCCD’s 12 campuses use the following: BHC, CVC, EFC, 

ECC, MVC, NLC, RLC, BPI, LCET, DO, and DSC. 

Board Always capitalized when used in reference to DCCCD’s elected 
governing body. 

District Always capitalized when used in reference to the Dallas County 
Community College District. 

Dollars   Omit decimal places if the amount is even dollars, e.g., present 
$35,000.00 as $35,000.  Retain decimal places if the amount is not 
even dollars, e.g., present $34,999.99 as $34,999.99. 

Font   Times New Roman 13 is required for the Board agenda and 
recommended for other documents.  If supplying an attachment to a 
bid or other agenda item, use this font if at all possible. 

Interlocal   Add this word to your Word spelling and grammar check.  It refers to 
contracts between governmental agencies. 

Margins/ 
View   

1.25” left and right margins, 1.0” top and bottom \ print layout view at 
100% zoom are required for the Board agenda and recommended for 
other documents.  If supplying an attachment to a bid or other agenda 
item, use specified margins/view if at all possible. 

Metroplex   Add this word to your Word spelling and grammar check.  It refers to 
the 16-county Dallas-Fort Worth Metroplex. 

Months   Always spell out the name of the month, e.g., September (not Sept.).   

Policy Always capitalized when used to reference something in the TASB 
Manual, e.g., Board Policy CF (LEGAL). 

Seasons   Uppercase Spring, Summer, Fall, Winter when a specific semester or 
term is stated or implied, e.g., Fall 2006, Winter Term, Spring 
[Semester implied]. 

Trustee(s) Always capitalized when used in reference to one or more members of 
DCCCD’s elected governing body. 
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Spelling & Grammar 
 

Although spelling and grammar checks help catch some mistakes, they are not 
foolproof.  Always proofread the document before sending it as well as running the 
spelling and grammar check. 

1. Hold down the Ctrl (Control) key on your keyboard and hit the Home key at the 
same time. This will take you to the beginning of your document. 

2. Open the Tools menu (Word 2007 under Review tab) and select Spelling and 
Grammar to display the dialog box  

3. Word will find each spelling and grammar mistake it thinks you made and ask you to 
correct the mistake or ignore it.   

4. When Word indicates passive voice, re-write in active voice if at all possible. 

5. When Word suggests different phrasing, it implies the existing phrasing may be 
ambiguous.  Consider re-writing. 

6. When Word indicates long sentence, no suggestions, consider re-writing. 

7. When the check is finished, Word will notify you. 

 

 

Red text indicates a 
spelling error. Green 
text indicates a 
grammar error. Click 
here to correct a 
mistake manually. 

Click Ignore to 
ignore this error 

Click Add to add the 
word to the dictionary 
if it really is spelled 
correctly 

Undo the last change 
or ignore made 

Click Close when the 
check is finished 

Click Ignore All to ignore all 
of this kind of errors 

Word displays 
suggestions here. 
Click the suggestion if 
it is correct, and then 
click the Change 
button to change this 
occurrence. Click the 
Change All button to 
change all of the same 
occurrences. 
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Saving the Document 
 
After creating the document based on the appropriate template, save it to your 

computer for reference later if you wish. If you want to save the document, use the 
following steps: 

1. Open the File menu and select Save As… 

Step 2: Save in: field 

Step 3: File name: 
field 

Step 4: Save as type: 
field 

Step 5: Save button 

2. From the Save in: field at the top of the box select the location on your computer or a 
network drive to save the document for future reference.  Select the My Documents 
folder on your computer or your P:\ drive or U:\ drive on the network.  [Note: Your 
P:\drive or U:\ drive is preferable because files there are automatically backed up 
whereas if your desktop computer fails, your files may be lost.] 

3. Type in a filename in the File name: field at the bottom of the box using this 
convention: Location Primary Contact’s last name Contractor.doc.  For example: 

 

BHC_McCrary_TNRCC.doc 

ECC_McCarthy_UTSWMC.doc 

NLC_Glasscock_DFW_Airport.doc 

DO_Blell_MDLH.doc 

DSC_Green _D&T_audit.doc 

 

4. Leave the Save as type: as Word Document (Word 2007 as Word 97-2003 Document) 
for this document  

5. Click the Save button. 
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Sending the Document to the EVCBA’s Editor 
  
The next step is to send the document to Daisy Ollie with cc: to Barbara Corvey, 

Linda Gomez, your primary contact (see p. 3), business officer, originators, and backup 
editor through GroupWise e-mail.   
 
Sending the File From Word via Email 

1. Double-click the My Computer icon on the desktop of your computer screen. 

2. When the My Computer window opens you will see a list of all the drives you have 
access to on your computer, organized by letter. 

3. The C: drive is your computer. If the file has been saved on your computer, double-
click the C: drive icon and any other folders to get to where you saved your file. 

4. The U: drive is your personal network drive. Double-click it if you saved your file 
here and navigate through any other folders to get to where you saved your file. 

5. Open the file. 

6. From the File menu, select Send To, and then select Mail Recipient (as attachment) or 
GroupWise Recipient. 

7. A new e-mail message will open with your document automatically attached.  

8. Enter the address of the person/people you are sending the document to, along with a 
message, as follows:  

 
9. Click the Send button. 
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Finishing the Job 
 

The final step is to ensure the associated 3 original contracts (if any) are in 
Daisy Ollie’s physical possession with Legal’s approval (Robert Young’s initials on 
each original) on or before the cut-off date/time. Depending on the time frame, this 
may be accomplished via interoffice mail, courier or otherwise. The agenda item is 
subject to deferral to the next month if Daisy does not have all materials at her desk on or 
before the cutoff date.   

 
NOTE: If contracts, contract amendments or change orders make reference 

to appendices, attachments, letters of agreement, or other documents, these must be 
attached for the material to be considered complete. 
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Updating the Templates 
Periodically, new templates and/or updates to the templates may be created and 

made available to you via the intranet. The templates can be accessed online at 
www.dcccd.edu/dsc/dsc-home.htm. Click the Business Affairs Intranet link.  The 
templates are located under the section “EVCBA's Board Agenda Templates”  

Follow the steps below. 
To save an update to an existing template 

The updated template will have the same name as one you have already saved and 
been working with. 
 

1. Save a template following the Save Additional Templates steps 1-5 on page 13 

Save in 

Save as type 

Board Templates 
folder  

File name field and 
Save button 

2. Since this template is an update to an existing template, one you have already saved, 
select the template that you are updating from the list in the Board Templates folder  
and click the Save button. 

3. A box will display asking if you want to overwrite the existing file. 

4. You do want to overwrite the existing file because this is an update so click the OK or 
the Yes button to save the file.
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Appendix A: DCCCD Board Agenda Resources 
 
Resource Business Officer 

Richard McCrary 
Interim President 
Brookhaven College 
(972) 860-4806 

George T. Herring 
Vice President of Business Services 

Jennifer Wimbish 
President 
Cedar Valley College 
(972) 860-8250 

Huan Luong 
Vice President, Business Services 

Andrew Jones 
Executive Vice Chancellor of Educational Affairs 
District Office 
(214) 378-1808 
 
Denys Blell 
Executive Vice Chancellor of Human & Organizational 
Development 
District Office 
(214) 378-1812 

Kathryn Tucker 
Executive Director, Board Relations 
District Office 
(214) 378-1609 

Betheny Reid 
Associate Vice Chancellor, District Foundation and 
Resource Development 
District Office 
(214) 378-1538 
 
Robert Young 
District Legal Counsel 
District Office 
(214) 378-1703 

Edward DesPlas 
Executive Vice Chancellor of Business 
Affairs 

Edward DesPlas 
Executive Vice Chancellor of Business Affairs 
District Service Center 
(972) 860-7752 
 
Kim Green 
Associate Vice Chancellor of Business Affairs 
District Service Center 
(972) 860-7710 

Edward DesPlas 
Executive Vice Chancellor of Business 
Affairs  
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Software Training 25 Appendix A: 
 DCCCD Board Agenda Resources 

DCCCD Board Agenda Resources, con’t 
 
Resource Business Officer 

Jean Conway 
Interim President 
Eastfield College 
(972) 860-7001 

Jim Jones 
Vice President of Business Services 
 
 

Paul McCarthy 
President 
El Centro College 
(214) 860-2012 

David A. Browning 
Vice President of Business Services 
 
 

Felix Zamora 
President 
Mountain View College 
(214) 860-8700 

Sharon Davis 
Vice President of Business Services 
 

Herlinda Glasscock 
President 
North Lake College 
(972) 273-3010 

Christa Slejko 
Vice President of Business Services 

Pam Quinn 
Provost 
R. Jan LeCroy Center for Educational Telecommunications 
(972) 669-6550 

Dottie Clark 
Dean of Financial Affairs 
 

Kathryn K. Eggleston  
Interim President  
Richland College 
(972) 238-6364 

Ronald M. Clark 
Vice President of Business Services 
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